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What is EZNEC

* It’s rocket science
* Originally written in Fortran
e Lawrence Livermore National Laboratory in 1970s

* You don’t need to be a rocket scientist to use it.

* You need:
* To be readily aware of is terminology
* Nomenclature
* Methods of opening dialog boxes
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Why Have an Intro?

* The EZNEC help file is magnificent in its introduction to the software.

* Yet, the average amateur radio operator needs a kick-start to get
going.
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What Presented

* The GUI
* Dialog Boxes named and identified

A stick-representation of an antenna
e Stimulus

* Radiation Pattern

* Next Steps



1Chart Trainin... (@l EMI-15200C X Tank Volume Calcul.. [ Se

Getting Started e Google

Antenna Software by W7EL

0. eznec download eP X & @
FREE - EZNEC Pro+v. 7.0 is now available! - FREE
e e | :'T . Google Search I'm Feeling Lucky
= ”ﬂ’ﬁﬁ“‘ - i ) | . Tuuyic TLITU LU UGy
MM - Videos Free Images Shopping Perspi

About 28,600 results (0.25 seconds)

EZNEC Antenna Software by WT7EL
an "slice” highlighted. Any asimut or elevation slice can be highlighted. Ceanter: View Antenna display, showing the “wires” making w the moded of the fiv @ . -
isplay shawing detailed infomation about the selecied lice. httpSHWWW eZnec.com H

What's New in v. 7.0 ZNEC Antenna Software by W7EL

- + i i I-
Al fealures which wene available in EZNEC Prov2 v. 6.0 are incorparated inlo EZNEC Prov2e v. 7.0 wilh a few exoeptions desoribed below. EZNEC Praid v 8.0 was identical o EZNEC Pro/2 except far the indusion of an intemal NEC-4.2 caloulating EE - EZNEC Pro+ v. 7.0 is now available! - FREE ... Abo
NEC displays. Right: 3D far field pattern, with 2D elevatic

Abova: Son
Sevweral of

fiedd paitem, wilh 20 she
5 display. Left:

ar

m sevaral EZNEC o
curren

- Extemal caboulating enpginea - Both EZNEC Prov2s and EZNEC Profd+ can use exiemal NEC-4.2 and NEC-5 programs for calculstions. After installing EZNEC Prov2+ oe EZNEC Prodés, cpen the manual (Help/Gonlenis) then open he Refe
the=s and how o get them,

= Individual wirg Beee - Each wire can have different loss if desired

EZNEC v. 6.0 Maintenance ...
EZMNEC v. 6.0 Maintenance Updates. EZNEC Pro/2+v. 7

»  Improved NEC format fils reading - A number of deficendes were addressed and comecied.

= Plof dizpiay snhancemants - Line wit

nd abject sizes can be changed in the 20, 30, 3WR, and View Antenna displays.

- Charga denally table - Mew Opfions menu selecion t oponally add charge density dala o the Currents able

- Example Migs and Teet Drive updates - Cxample files have been updated o replace MIMIMES & ground with Real, High Accuracy ground where MININEC ground isn' needed. The Test Drive tutofal has been updated
calculting engine. Original versions of example files which were changed are in @ Legacy subdinectory.

Printable manual for EZNEC ...

The EZNEC Pro+ v. 7.0 manual is in the form of a help fi

- Undo Calculating Enging Changs - Certain features sulomatically enabled o

sabied, and items such s 2 second ground medium can be deleted when changing calodating engines. So calculation engine chanpe

- Wirs Sagment Infersachon Conversion - Descriplions conlsining wires inlersecting al segment junclions can automalically be comered 1o the now-required wire end connections.

Cllck hers to ese deleted features and other changes.

Here
So don't delay if you want the upgrade, and be sure to m

Download EZNEC Pro/2+ v. 7.0
Highly recommended! NEC-5

-- New v. x13 available(*) NEC-5
Highly recommended! AutoEZ NEC-5 - Allows buried conductors - Not subject to steppe
EZNEC Pro/4 users click here for a free upgrade to EZNEC Pro/4+ More results from eznec.com »

*l Qas 'MNEM.E annins carnand ravician naw availahla ke ACRD A far infarmaftinn shant NECUE madifiad varcinn v13

g [nformer Technologies

Wesley Cardone, N8QM



Now, Learn the Terminology

e The “Control Center”

* Upon invocation, the Control Center appears.

* The help screens pretty much assume that you,

as the viewer, recognize
this nomenclature.

* You need to learn to
recognize these names.

ﬁ‘.

Open
Save bz
ant Matesz

| Currents
| SmcDat
Load D at
FF Tab
MF Tab
SR
Wiew bt

MNEC-2D

File Edit Options Outputs Setups View UHilities Help

> Back yard dipole
File LAST.EZ

» | Frequency 21.2 MHz
el avelength 14142 m

> | Wires 4% ires, B8 segments

> | Sources 1 Source

> | Loads 0 Loads

> | Tranz Lines 0 Transmizzion Lines

> | Transformers 0 Transformers

> | L Hetworks 0L Metworks

> | Ground Type RealMIMINEC

> | Ground Descrip 1 Medium [0.0303, 20

> | Wire Loss Copper

> | Unitg teters

> | Plot Type a0

> | Step Size A Deq

> | Ref Level 0 dBi

> | Alt 5WR Z0 300 ohrms

» | Desc Options
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Information Window Title Bar

* There exist “information
windows.”

* The banner of the control center
is called the
“Title Bar.”

LB

R

File Edit

Open
Save As

Ant Hates

Currentz
Src Doat
Load Dat
FF Tab
MF Tab
SR
Wigw Bt

MELC-20

T e e P (T T T T T RV P P

R T T T

le
Frequency

W avelength
Wires

Sources

Loads

Trans Lines
Transformers

L Metworks
Ground Type
Ground Descrip
Wire Loss
Units

Plot Type

Step Size
Ref Level

Al SWR Z0
Desc Options

21.2 MHz

141412 m

4 W/fires, 88 zegments
1 Source

0 Loads

0 Tranzmizzion Lines
0 Transfarmers

0L Mebworks
RealMIMINEC

1 Medium [0.0303, 20)
Copper

M eters

ab

5 Denq.
0 dBi
300 ohms
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Information Windows

* There exist “information
windows.”

* The banner of the control center

is called the
“Title Bar.”

* There exist a variety of other
information windows.

LB

T
File Edit Options atpL Setups  View Utilities Help
> Back vard dipole
Open File LAST EZ
Save As Frequency 21.2 MHz
Ant Notes wavelength 141412 m
Cuiments » | Wires 4 W/fires, 88 zegments
Sre Dat * | Sources 1 Source
Load Dat * | Loads 0 Loads
FF Tah * | Trans Lines 0 Tranzmizzion Lines
' MFTab » | Transformers 0 Transfarmers
' SR * | L HNetworks 0L Mebworks
View Ant * | Ground Type FealMIMIMEC
- * | Ground Deszcrip 1 Mediurm [0.0303, 20]
* | Wire Loss Copper
* | Units M eters
| NEC-ZD * | Plot Type a0
* | Step Size 5 Denq.
i > | Ref Level 0 dei
Alt 5%WR F0 300 ohms
*Q Desc Optio
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Info Windows—Openable and Informational

* There exist “information
windows.”

* The banner of the control center

is called the
“Title Bar.”

* There exist a variety of other
information windows.

LB

S
File Edit

Open
Save As
Ant Hates

Currentz
Src Doat
Load Dat
FF Tab
MF Tab
SR
Wigw Bt

* Those with “>” sign produce dialog

boxes.

* Those without “>” sign are only for

informational purposes.

MELC-20

|
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Options

Outputs

Setups

View LUtilities Help

E

T e e Vo (T T T T e RV R

R T T T

Loads

Trans Lines
Transformers

L Metworks
Ground Type
Ground Descrip
Wire Loss
Units

Plot Type

Step Size
Ref Level

Al SWR Z0
Desc Options

Ui%iil“ gdinole

4 Wires, B8 zegment

0 Loads
0 Tranzmizzion Lines
0 Transfarmers

0L Mebworks
RealMIMINEC

1 Medium [0.0303, 20)
Copper

M eters

ab

5 Denq.
0 dBi
300 ohms




Action Buttons

e Action Buttons provoke actions.
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Open
Save bz
Ant Motes

Currents
Src Dat
Load Drat
FF Tahb
MF Tab
SR

FF Plat

\/

Wiew At

Options  Qutputs  Setups  View Utilities  Help
> Back vard dipole
File LAST.ES
* | Frequency 21.2 MHz
YW avelength 141412 m
| Wires 4wiires, 88 segments
» | Sources 1 Source
* | Loads 0 Loads
* | Trans Lines 0 Tranzmizzion Lines
* | Transformers 0 Transfarmers
» | L Networks 0L Metworkz
* | Ground Type Real/MINIMELC
* | Ground Descrip 1 Medium [0.0303, 20)
» | Wire Loss Copper
> | Units Meters
* | Plot Type 3D
> | Step Size 5 Deq.
> | Ref Level 0 dBi
> | Al SWEH Z0 300 ahmz
» | Desc Options




Action Buttons

& |-€
5ik
i i JL i g J JLTE 3 i L I'r.- L4 h iliti 5 J
File Edit Options Outputs Setu lew  Utilities  Hel
. . > Back vard dipole
* Action Butt ke act i
Ction buttons provoke actions. File LAST EZ
Frequency 21.2 MHz
“ ” : : At Maotes
e “O b d dial b k Wi avelength 141412 m
pen” button produces dialog box asking | Anttete! aveleng Ltz
f f' | Currents ¥ es ez, SE‘-‘QI’I’IE-'I"I':S
or arTile to Open Src Dat » | Sources 1 Source
Attachments B 0 % LDad Dat ’ Luads - I:I LDadS P .
pen
——— e . FF Tab » | Trans Lines 0 Transmission Lines
& Documents T8> TEK e 0 An e - ME Tah > | Transformers 0 Transformers
bl | . SR SR » | L Networks 0L Metworks
[ This PC i2 Cascades Amg#ur Radio Society A Name Status Type ~
= M 3D Objects puter Media Photos £ dsqtl.ez E—— Wiew Snt > Ground T_',FPE ) HEEl|.-"|"-"||N|NE|:
R _5:_4SquarELNetwurk Feed ARRL Example.ez rogram Fi * ElDl.Iﬂd DESC"I] 1 ME!IjIL.IITI [I:II:ISI:IE_. EI:I]
File Edit Options Ouf _5;_4SquareLNetworkFeedW\chMatchm... C gram Fi =
E e 5 45quare TL ARRL Example.ez C:\Pro%gam Fi * WIIE LDSS I:DI:'I:'E[
st || 5 rroa (74 dsquare.ez C:\Progm i * | Umits Meters
Ant Motes Wavel | Documents ﬁ‘,15mquad‘ez Ch\Progral Fi
Ve > | Wire =] Pictures 5% 20mSelya.ez C:\Progran@gFi NEE-ED > Flut T.ll'pe 3D
Src Dat >_| Sour . % backyard dipole2.ez C\Programigi
oa This PC €]
L:Fa?:_:;t z If[a: 1D Object % BVDipole.ez C:\Programgii FF PlDt _
MF Tab > | Tram: s o ktjec : _';:_BYDipnIEZEDDm.ez C\PrograrFi } StEp Sle 5 DEQ
Swih > | L Nel eskiop A% i y 5 r -
Vewbn || [2>] Grou Documents L eertieres EE'CT | » | Ref Level 0 dBi
> | Wire Downloads _‘f_CardimdLNetworkFeedARRLExample‘ez C:h\Progfm Fi } Alt SWH zu 3':”:' Dth
>_| Unitg l::_Can:llmt:ITLJ-'\RRLB(amr;lle.ez C\Prgliram Fi -
riicpf[: 2] Flob _5:_Cardimd.ez C: gfogram Fi } DESE uptluns
ﬁ > | Step ﬁ:,CardTL.ez WProgram Fi
> |Refl 7% d_45qTlez :\Program Fi
2| Alt S 5 d Aeonare F7 C\Prnaram Fi ¥
> | Desc >
Cancel

PR ARE R AF PR A e FTRir irm ¥ ArruAnTnRE fr
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Action Buttons o

A

B
File Edit Options

Outputs  Setups

View Utilities Help

. » : Ldinole
* Action Buttons provoke [ Open | (€ TFk Y Dipole.c2
. Save As » | Frequency TRz
actions. Ant Notes Wavelength 70.2551 f
" ” CLments > | Wires 1%Wfire, 11 zegments
e “Open” button produces i > | Sources 1 Souwse
dialog box asking for a file to | LoadDat| |2 Loads Oloads
FF Tah > | Trang Lines 0 Transmigsion Lines
(@) pe n. MF Tab » | Trangformers 0 Tranzformers
. SR * | L Metworks 0L Mebworks
* Once opened, file name — > | Ground Type  Real/MININEC
. . . . D » | Ground Deszcrip 1 Medium [0.0303, 20)
appears in the file information o P o
W| N d OW. | Units Feet
MEC-2D > | Plot Type Elervation
5 FE Plat > | Azimuth Angle 0 Deg.
| Q * | Step Size 1 Deq.
| > | Ref Level 0 dBi
> | Al SWR Z0 75 ohmz
> | Desc Options
T — 1
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Easiest Way to Depict and Define an Antenna?

* If you had to pick a way that you would like
to use to define an antenna architecture...
What would you use?



Easiest Way to Depict and Define an Antenna?

* If you had to pick a way that you would like

to use to define an antenna architecture... ‘,Z
What would you use? |
I
* Why not use a stick-figure. o 1 oo Y
O O # O
(0,0, 10)' y; #2 (1,0, 10)

e ’
/
‘ ————————————————————— - X
/
/
Height above Y
e | x| |2 i | S8 /
1 -1 0 10 1 10

2 1 0 10 1 10
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Open BYDipole.ez

* Click the “Open” action
button.

* Navigate to BYDipole.ez
* Click Open.

B EZNE — |
File Edit Options OQOutputs Setups View Utilities Help i
» Back vard dipole |
File BvDipole. ez
* | Frequency 14 MHz L
Ant Notes Wwavelength 70.2551 ft
CLments > | Wires 1%ire, 11 zegments
Sre Dat Sources 1 Source
Load B tL Loads 0 Load S _ .
== : 20m3elya.ez 1/1/1997 9:44 PM Ch\Program Fi
M 7. backyard dipole2.ez 171572021 12:43 PM CProgram Fi
= 7 BYDipole.ez 8/1/1996 10:03 AM CA\Program Fi
\ig l?' BYDipole2200m.ez 5/27/2021 11:04 AM C:\Program Fi
l:a' BYDipoleFullWave.ez 572772021 1013 AM CProgram Fi
7% BYVee.ez 8/1/1996 10:03 AM Ch\Program Fi
3 Cardioid L Network Feed ARRL Example.ez 5/16/2007 12:40 PM Ch\Program Fi
MEL 5 Cardioid TL ARRL Example.ez 11/15/2008 2:39 AM C\Program Fi
FF 5 Cardioid.ez 8/1/1996 10:04 AM Ch\Program Fi
E— 5 CardTL.ez 8/1/1996 10:04 AM C:\Program Fi
7% d_AsqTlez 2/18/2001 4:35 PM C:\Program Fi
5 d deanare F7 5/13/2000 12:22 P C:\Prnaram Fi
LU 4 >
w | |EZMEC files (*.EZ) w
Open Cancel
Wesley
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Info Window Reflects Opened File

* The information window
“File” confirms that the
antenna has been loaded.

* Click the action button
“View Ant.”

Wi

Ly

ECR
File Edit

| Open

Save bz
Ant Mates

Currents
Sz Dat
Load Dat
FF Tahb
MF Tab

( iew it )
.

MEC-20

FF Plat |

Options

Outputs  Setups

View Utilities Help

A s

W avelength
Wires
Sources
Loads

Tranz Lines
Transformers
L Metworks
Ground Type
Ground Descrip
Wire Loss
Units

Plot Type
Azimuth Angle
Step Size

Ref Level

Alt 5WH A0
Desc Options

025651 |

1'Wfire, 11 segments
1 Source

0 Loads

0 Tranzmizzion Lines
0 Transformers

0L Metworks
Real/MIMNINEC

1 Medium [0.0303, 20)
£erm

Feet

Elewvation

0 Deq.

1 Deq.

0 dei

0 ohms




Open BYDipole.ez

* The stick-view
representation of the Back
vard dipole antenna
appears.

A

W 1
File Edit Options OQOutputs Setups View Utilities Help i
» Back vard dipole |
[ Open File BYDipale.ez
Save As * | Frequency 14 MHz L
Ant Notes wavelength 702551 ft
Cunents > | Wires 1%Wfire, 11 zegments
i E s O] ; Couurae 1 Smurme
Load Dat l B3 View Antenna: Back yard dipole
FF Tah || File Edit View Options Reset
MF Tab EZI
Z
MEC-2D
FF Plot —4
—

Wesley Cardone, N8QM



Where Do the Wires Information Reside

* Click the information
window “Wires.”

* The tabular (stick) view
information window for the
antenna appears.

A

CHH

File Edit

| Open

Save bz
Ant Notes

Currents
S Dat
Load Dat
FF Tab
MF Tab
SR

Wiew dnt

Options  Qutputs  Setups  View Utilities Help
» Back yard dipole
File BY'Dipole.ez
» | Frequency 14 MHz

B3 View Antenna: Back yard dipole

File Edit Wiew Options Reset

i}

Wire Create Edit Other

- [~ Coord Entry Mode

[~ Preserve Connections W Show ‘Wire Inzulation

Wines —
M. End1 End 2 Diameter | Seqs [nzulation
= () SO[F) Z (/] Corn = (i) NO[H) Z (/) Cotin [ir] Digl C | Thk [in)
k|1 1] 1] a0 1] 3343 a0 12 11 1 1]
*

Wes_léy Ca rcTone,
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Stick-View, Tabular Representation

* There is one wire making up this antenna.
* The tabular (stick) view information window for the antenna appears.

 Starting point (Ending #1)
e Ending point (Ending #2)

B3 View Antenna: Back yard dipole

File Edit VYiew Options Reset

. EZI

* What could be simpler?

* Note: No gap is defined.
- — —r
Wire Create Edit Other
[ Coord Entry Mode I;';ieserve Connections W Show 'wire Insulation

4E'H'd'“l HL = —
0 _Ea%ter Seqs [nzulation
[in] Diel C | Thk [in)
4 #1z2 11 |1 0
*
I
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Time for Some Wave Theory

* Piano String and acoustic energy

* Fork movement creates pressure interpreted by your ear as a sound.

 What vector direction does it have?
e Some directionin X
e Some directioninyY

* What happens when you pluck
a guitar string?

* [t moves and creates acoustic
energy by barometric
pressure changes.




Pluck a Piano String

* Pluck a guitar or 100% X direction

: ) _ 0% Y directi 50% X direction
el string and it 0% ¥ direction \ 50% ¥ direction
ViDrates.

* Crest of wave Only Compression Amplitude

pushes to the X

* Mid-position splits
energy between X
and Y.

* What does this
mean?

Wesley Cardone, N8QM



Pluck a Piano String

e It means that more  Component to the X much

larger than to the Y. Component to the Y

energy is directed \ smaller than that to the X.

to the X than to
the.

Compression Amplitude

Wesley Cardone, N8QM



The Resulting Sound Envelope

* [t means that more

energy is directed More sound to the
to the X than to longitudinal.
the Y.
Compression Amplitude

* This applies to
electro-magnetics
in the same way.

* Remember that
thought.

Less sound
the ends.

5 sound to
5 ends.

Wesley Cardone, N8QM



The Radiation Pattern

. . . id
° ClICk On the Informatlon FE:IE Edit Options Outputs Setups View Utilities Help
window “Plot Type.” i > Back yard dipole
pen File BY'Dinole ez
Save hs 0 -
* Click “3 Dimensional.” aitaes] |
| — y Select Plat T_'.-'I:IE-' ....................................
* Then Ok | “CcDat > &~ S
Load Dat :;
. . FF Tab Cancel
* Then click the action button NFTab || |2 ¢ agimuth -
*
”FF PIOt.” ‘»-’igl.fint > {# Elewvation
i (" 3 Dimensiona
* This calls the far-field plot. = ,
e N
> = ) = = smwa N
@’ > | Step Size 1 Deq.
* | Ref Level 0 dei
1 > | Al SWH 20 7 ohms
* | Desc Options

Wesléy Cardone, N8QM



Pattern

lon

|at

The Rad

* You are looking at a very fat doughnut having almost no hole.

indows for comparison.

e Position the two w

* Take a moment to visually correlate the 3 axes.
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Pattern

lon

|at

The Rad

* Now think about the piano string.

* There is no movement

e At either end or
e At the center.

o
i

e

PRy %
Y

T
s
|

L

ol
'l

!
%1-
e
e
L

TR
14

i

Y
I

v AT
ﬁ&ﬁ. | *_?r

il
i
Wi
il
i
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* These points are fixed. .,



Add to the View

* |n the “View” menu

* Click “Objects...”
B3 View Antenna: Back yard dipole

Yiew Antenna

File Edit View Options Reset

[ Currents Show Controls

- Show Virtual 5eg Conn

r

[ Unconnected Ends

[ “Wire Humbers

~
"

[ 2D Pattern
~
~

[v 2 Port Objects ==t

Ok

Wesley Cardone, N8QM




Add to the View

* Click “2D Pattern.”

* Is it making more sense now?

* There are several ways to view a radiation pattern from
different perspectives

Wesley Cardone, N8QM
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Experiment

* Two dipole verticals
» Separated by a half-wavelength
* Fed at zero degrees phase...
* Will concentrate energy front to back.

* But there is not enough width to mount
the antennas a half-wavelength apart.

* Solution: make up for the lost half-
wavelength by adding the correct phase ~
difference to the second feed. o
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Radiation Pattern Sinélle

* Plot the radiation pattern for a single
vertical antenna.

* Witness
* 3D pattern

e 2D pattern showing that marked in red in

the 3D pattern

Mo,

End1

End 2

Diameter

Seqgs

& [m)

" [m)

< [m)

Conn

& [m)

" [m)

Z [m]

Conn

[mm]

7976

#12

100

—_
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1M, Crida | Crig =

(B [= [} | L8 =]} Qe IT AT

= [m) ¥ [m) £ [m) Conn # [m] ¥ [m) £ [m] Conn [rrm] DielC | Thk [rm] Log
1 0 0 7 1] 0 8.015 2 101 1] 1]
]2 0.97602 0 7 0.97602 0 b5 2 11 1] o
Radiation Pattern Dual i
Mo, Specified Pos. Actual Pos. Amplitude Phaze | Type
‘Wire # | % From E1 | % FromE1 | Seg | [V. &) [deq.)
(2l 1 50 49.5 50 1 1] |
: 2 2 50 495 50 1 0 |

* Plot the radiation pattern for a dual vertical antenna.

* Withess

* Squashed side-to-side pattern
* Elongated front-to-rear pattern

Wesley Cardone, N8QM



¥ [m) % [m) Z [m) Coann ¥ [m) % [m) Z [m] Cann [rrrn) DiglC | Thi
b1 0 1] 2 1] 1] 297603 12 100 (1 0
2 0 1] 322004 1] 1] 4 19607 #12 100 (1 0
*

What Would Happen w

e Dual stacked verticals
e Wire #2 phaSEd at 15° (solved by iteration)
* Gap A/8 which is 0.244 meters

299.79

e 222729 9521 = 0.4538 meters
146 4

* Energy otherwise directed toﬂd’ghe moon
to the horizon.

Dual Stacked Vertical

Single Vertical

Wesley Cardone, N8QM

th Stacked éntennas?

Actual Pos.

Mo Specified Pos. Amplitude Phase | Type
wie | % FromE1 | % FromE1 | Seg | [\, &) [deq.]
k1 1 50 495 50 1 0 |

2 0

435

&0

1

15 |




Your Next Steps

) EZNEC v. 7.0 User Manual

T =
* You are invited to take Hide Print_ Options
the EZNEC “Test
Drive.”

* |s organized according @ Getting Started

to skill level. ) Test L
* Along the Straightaway | (2 Aong The Steightaway
. S E Through The Curves
* Gets you started with - ~[2] On The Race Course
the uttermost basics. - [2] ALap Around Track 5
i i |?] Taking Car & For A Spin
* Through the Curves . [2) Plus Octane Fill Up

- Buiding The Model

e Adds some easy stuff 51 Interpreting The Results

* And the tutorial list -4 Reference
% Legal Notices
goes on. 53-8 Suppor

Wesley Cardone, N8QM

Welcome

Welcome to E.?_'I-.IE{ZIEI Pro+ vers

This manual has been written t
and EZNEC Pro/d+ with their @
variations. "EZNEC” or "EZNEC F

Its assumed that you know |
such as clicking, dragging, anc
will occasionally be made o
such as Motepad or the Window
your Windows documentation
basic Windows techniques.

There will be no support ava
manual. | regret that | won't re
any means including email. |
anticipated.

EII-.IEEIEEI i5 aregistered trademnr
rights are reserved.



Questions
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